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1. Description

This user guide provides an introduction to Workshop4, the 4D Labs integrated development environment.
Workshop4 supports multiple development environments for the user, to cater for different user requirements and
skill level.

The Designer environment enables the user to write 4DGL code in its natural form to program
4D Labs processors of choice.

A visual programming experience, suitably called ViSi, enables drag-and-drop type placement of
objects to assist with 4DGL code generation and allows the user to visualise how the display will
look while being developed.

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all, it is all done
automatically. Simply lay the display out with the objects required, set the events to drive them
and the code is written for the user automatically. ViSi-Genie provides the latest rapid
development experience from 4D Labs. (Not available for Goldelox)

ViSi-Genie
T

A Serial environment is also provided to transform display modules powered by 4D Labs
processors into a slave serial module, allowing the user to control the display from any host
microcontroller or device with a serial port.

Serial
—

Additionally, Workshop4 also offers Arduino compatible environments that allows the user to easily create a project
with both a 4D and an Arduino product. More details can be found in Choose Your Arduino Compatible Environment.

To install Workshop4, please refer to the document Workshop4 Installation.

© 2017 4D Labs Semiconductars Page 4 of 49
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2. Workshop4

There is an alias for 4D Workshop on the desktop:

Launch 4D Workshop by double-clicking on the icon:

workshop

© 2017 4D Labs Semiconductors Page 5 of 49
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3. Create a New Project

Workshop4 opens and displays the Recent page:

WORKSHOP PRO
IDE Yersion 4.4.0.9

Create a new 4D Systems Project

Start building a new Visi, Genie, Designer or Serial program.

P.;‘ Print Setup P
'«) Create a new 4D Labs Project
- = | Start building a new Visi, Genie, Designer or Serial program.
e
; Options

Hel [ 4 .
“ | Create a new Project
| '3 Start building a new program using the same settings as you

@ samples = last used (Arduino Extended Graphics 4Duina)
% it

4D SYSTEMS 4D LABS

TURNING TECHNOLOGY INTO ART SEMICONDUCTORS

Recent (Click here to Clear)
ColorPicker.4DGenie 8/20/2013 10:30 AM

I
ﬁwj c:\Users\PubliciDocuments|4D Labs\Picaso Visi Genie\Colorider4DGenie

CLOCK.4DViSi 11/1/2011 3:43 PM

c:\Users\PubliciDocuments'4D Labs\Picaso ViSI\CLOCKADVIS

SPIflashDemo.4dg 3f11/2014 7:59 AM

C:\Users\Public\Documents'4D Labs\Diablo DesignenSPHashDemoAdg

Scroll using mousewhesl, or click and drag using left mousebutton

To create a new program, there are multiple options:

o  Click on the top left-most icon New

© 2017 4D Labs Semiconductors
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e (Click on the icon close to Create a new 4D Systems Project on top
e Click on the Create a new Project to create a project instance based on your last project settings.

Create a new 4D Systems Project

Start building a new Visi, Genie, Designer or Serial program.

Create a new 4D Labs Project

Start building a new Visi, Genie, Designer or Serial program.

Create a new Project
Start building a new program using the same settings as you
last used (Serial Gend4-uLCD-32DT)

Note: Another option is displayed on the image above. Create a new 4D Labs Project is an upcoming
Workshop4 feature which allows to create a project with a customized display module powered by 4D
Labs’ processors

Both of the first two options update the main window with the selection of the screen:

Gen4-uLCD-28DT 240x320

2.8"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Resistive Touth
panel

Gen4-ulLCD-32D 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-ulLCD-32D-CLB 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processorw/ Cover Lens Bezel

Gen4-ulCD-32DT 240x320
3.2"Gen4Intelligent Display Module with embedded DIABLO 16 processor w/ Resistive Toudh
panel

Gen4-uLCD-32DCT-CLB 240x320

3.2"Gen4Intelligent Display Module with embedded DIABLO16 processor wjf Capacitive Touh
panel & Cover Lens Bezel

Gen4-ulLCD-35D 320x480
3.5" Gen4 Intelligent Display Module with embedded DIABLO16 processor

Portrait (Click image to rotate)

Gen4-ulLCD-35D-CLB 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processorw/ Cover Lens Bezel

Gen4-ulLCD-35DT 320x480

3.5" Gen4 Intelligent Display Module with embedded DIABLO 16 processor wj/ Resistive Toudh
panel

Gen4-uLCD-35DCT-CLB 320x480
3.5"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Capacitive Touh
i~ D amal

e s

Scroll using mousewheel, or click and drag using left mousebutton

© 2017 4D Labs Semiconductors Page 7 of 49
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Select the screen, here the gen4-uLCD-32DT

Gend-ulLCD-32DT 240%320
3.2" Gend Intelligent Display Module with embedded DIABLO 16 processor w) Resistive Toudh
panel

The selected screen is displayed:

CHOOSE UR PRODUCT

Gen4-uLCD-28DT 240x320
2.8"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Resistive Toudh
panel

Gen4-uLCD-32D 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-uLCD-32D-CLB 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processorw/ Cover Lens Bezel

Gend-ulCD-32DT 240%320
3.2"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Resistive Toud
panel

Gen4-ulLCD-32DCT-CLB 240x320

3.2"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Capacitive Toudh
panel & Cover Lens Bezel f—

v

Gen4-uLCD-35D 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Portrait (Click image to rotate)

Gen4-uLCD-35D-CLB 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processorw/ Cover Lens Bezel

Gen4-ulLCD-35DT 320x480
3.5"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Resistive Toud
panel

Gen4-uLCD-35DCT-CLB 320x480
3.5"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Capacitive Toudh

Ranal 0. Fatiar T Ann Dias;

Scroll using mousewheel, or click and drag using left mousebutton

© 2017 4D Labs Semiconductors Page 8 of 49
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Orientation is portrait by default. To set it to landscape, just click on the image of the screen to rotate it:

| CHOOSE YOUR PRODUCT ‘

Diablo Gen4 Gen4-....-D,-DCT,-DT ¥ I’—'——'

Gen4-ulLCD-28DT 240x320
2.8" Gen4Intelligent Display Module with embedded DIABLO 16 processor w/ Resistive Toudh
panel

Gen4-uLCD-32D 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gend4-uLCD-32D-CLB 240x320 - —

3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor wj/ Cover Lens Bezel

Gen4-uLCD-32DT 240x320

3.2"Gen4Intelligent Display Module with embedded DIABLO 16 processor v/ Resistive Toudh

panel

Gen4-uLCD-32DCT-CLB 240x320 —_—AD

3.2" Gen4 Intelligent Display Module with embedded DIABLO 16 processor w/ Capacitive Toudh
panel & Cover Lens Bezel

Gen4-ulLCD-35D 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Landscape (Click image to rotate)

Gen4-uLCD-35D-CLB 320x480
3.5" Gen4 Intelligent Display Module with embedded DIABLO16 processorw/ Cover Lens Bezel

Gen4-uLCD-35DT 320x480

3.5"Gen4Intelligent Display Module with embedded DIABLO 16 processor vif Resistive Touh
panel

Gen4-ulLCD-35DCT-CLB 320x480
3.5"Gen4Intelligent Display Module with embedded DIABLO 16 processor v/ Capacitive Toudh
or

AnnAl O Casine Vana DasAl

Scroll using mousewheel, or click and drag using left mousebutton

Press Next to proceed:

© 2017 4D Labs Semiconductors Page 9 of 49
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4. Choose Your 4D Environment

The main window now asks for the environment for the project:

CHOOSE YGUR ENVIRONMENT s‘yLiZ'm‘@ e

File File

Designer

The Designer environment enables the user to write 4DGL code in its A visual programming experience, suitably called ViSi, enables drag and

natural form to program the display module. drop type placement of objects to assist with 4DGL code generation and
allows the user to visualise how the display will look while being
developed.

Options
S - EPN|
ViSi Genie Serial

@ Help o

@ Samples An advanced environment called ViSi-Genie doesn't require any 4DGL A Serial environment is also provided to transform the display into a slave
coding at all, it is all done for you. Simply lay the display out with the serial module, allowing the user to control the display from any host
objects you want, set the events to drive them and the code is written for microcontroller or device with a serial port.

x Exit you automatically. ViSi-Genie provides the latest rapid development

experience from 4D Systems.

Four main environment options are available:
e Designer,

e ViSi,
e ViSi-Genie,
e  Serial

...and two editor options:
e  Create System File,
e Create Text File.

Each option opens a customised environment with specific commands and controls. Different projects using different
modules and environments can be opened simultaneously on Workshop4. The toolbar ribbon will adapt to the project
tab that is selected, to suit its environment.

© 2017 4D Labs Semiconductors Page 10 of 49
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Designer

The Designer environment enables the user to write 4DGL code in its
natural form to program the display module.

The Designer environment enables the user to write 4DGL code in its natural form to program the display module.
4DGL is a graphics oriented language allowing rapid application development, and the syntax structure was designed
using elements of popular languages such as C, Basic, Pascal and others.

.:— L L - W= \ \ O & ) =
Mew Open  Save SaveAs  Print Cut Copy Paste Delete Undo Redo Clear All - Mext Prev Set Find Replace Goto  Find Again Collapse Al Expand All Compile Comp'nLoad
File Clipboard Undo/Redo Bookmarks Find Cade Folding Compile

qb
|2 NoName 1= [x]

n "Gend4-ulLCD-32DT"
#inherit "4DGL_16bitColours.fnc”
c main()

(LANDSCAPE) ; //

t("Hello World") ;

Insert Press F1 for context sensitive help ,:}

To learn more about Designer, please to refer to the 4DGL Internal Functions Reference Manual and 4DGL
Programmers Reference Manual on the Workshop4 product page and to related application notes.

© 2017 4D Labs Semiconductors Page 11 of 49
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4.2, ViSi

A visual programming experience, suitably called ViSi, enables drag and
drop type placement of objects to assist with 4DGL code generation
and allows the user to visualise how the display will look while being
developed.

Avisual programming experience, suitably called ViSi, enables drag-and-drop type placement of objects to assist with
4DGL code generation and allows the user to visualise how the display will look while being developed.

M=« X008 5004520053 == © 0

w Open Sme SaeAs Pint | Cut  Copy Paste ClearAll Next FPrev  Set | Find Replace Goto FindAgain  CollapseAll Expand Al Compile Comp'nload

Fle Cliphoard Undo/Redo Bookmarks Find Code Folding Compile
[HNoneme 1=

|| Form

Object Inspector we
Form | Formi v
Object [Formt -

Properties | Paste Code | | Paste allCode

Name Form1
Bias Formt
Bgtype Color
Color Wtk
Image

Source

<

Insert Press F1 for context sensitive help .::

To learn more about ViSi, please to refer to the ViSi User Guide on the Workshop4 product page and to related
application notes.

© 2017 4D Labs Semiconductors Page 12 of 49
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4.3. ViSi-Genie

ViSi Genie

An advanced environment called ViSi-Genie doesn't require any 4DGL
coding at all, it is all done for you. Simply lay the display out with the
objects you want, set the events to drive them and the code is written
for you automatically. ViSi-Genie provides the latest rapid development

experience from 4D Systems.

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all, it is all done for the user. By simply
laying the display out with the wanted objects and setting the events to drive them, the code is written automatically.
ViSi-Genie provides the latest rapid development experience from 4D Labs.

Home

W

Source

E P @ @ |Backgrounds  Buttors  Digits Gauges 1O Inputs labels  Magic  Primifives  SystemMedia N
== h
" Build (Build)
New ~Open Save SaveAs Print Copv/load Copv/Load ﬁ w l. ﬁ
File Build

[ElinoName 1= [x]

[ Formo 3| | Object Inspector

( Form | Form0

1 Object |Formd

Properties Events
Name Formd
Alias Formd
Batype Color
Color WeLack
Image

4k

Insert

Press F1 for context sensitive help .::

To learn more about ViSi-Genie, please to refer to the ViSi-Genie User Guide on the Workshop4 product page and to

related application notes.

© 2017 4D Labs Semiconductors
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4.4. Serial

Serial

A Serial environment is also provided to transform the display into a slave
serial module, allowing the user to control the display from any host
microcontroller or device with a serial port.

The Serial environment is provided to transform the module into a slave serial module, allowing communication and
control from virtually any host micro-controller or device with a serial port.

For detail on this environment and steps on how to make your display module run under the Serial environment,

please refer to the Serial Command Set Reference Manual on the Workshop4 product page and to related application
notes.

© 2017 4D Labs Semiconductars Page 14 of 49
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4.5. Create System File

The Create System File option provides an editor for all 4DGL-related projects, so a user can create or edit a 4DGL
Include file, 4DGL Library file, a Function or System file. These can then be included in the user’s 4DGL code.

[
L= R OO 5005 1OO

New Open Save SaveAs Print Clear Al Next Prev St Find Replace Goto Find Again

File Clipboard Undo/Redo Bookmarks Find

NeName 1.inc™ [x]

»1

Insert Press F1 for context sensitive help .:i|

© 2017 4D Labs Semiconductors Page 15 of 49
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4.6. Create Text File

Create
=6
File

The Create Text File environment features a plain editor, suitable for writing basic documentation, application notes,
data files or anything else requiring plain text files.

= 1 5 = = x @ @ \ ~ N 4 ~,
R R= 486 6 % LSO K
New Open Save Save As %ﬁ Cut Cop P Delete Undo Redo Clear All Next Prev Set Find Replace  Goto Find Again

File Clipboard Undo/Redo Bookmarks Find

NoName 1. bt [x]

»1

Insert Press F1 for context sensitive help .::

© 2017 4D Labs Semiconductors Page 16 of 49
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5. Choose Your Arduino Compatible Environment

When choosing a 4D Systems product, you can see that there is a product group named Arduino Compatible which
includes both gen4-1oD-28T and 4Duino. It also includes a wide range of 4D Systems’ display modules setup with an
Arduino board.

Gen4-IoD-28T 240x320
2.8"QVGA IoD module

4Duino 240x320
2.4"QVGA powered by ATmega32U4, PICASO and ESP8266

& svstems

uLCD-24PTU-AR 240x320
2.4"QVGA Intelligent Touch ScreenLCD Module and Adapter shield

uLCD-28PTU-AR 240x320
2.8"QVGA Intelligent Touch ScreenLCD Module and Adapter shield

80 00608000

uLCD-32PTU-AR 240x320
3.2"QVGA Intelligent Touch ScreenLCD Module and Adapter shield

20000000 0000000008~ T-@

© °9273" V"0
uLCD-43PT-AR 480x272
4.3"IntelligentLCD Modulew/ Resistivetouch and Adapter shield

Portrait (Click image to rotate)

uLCD-220RD-AR 240x320
1.38"Diablo16 Round Intelligent LCD Module and Adapter shield

uLCD-43D-AR 480x272

uLCD-35DT-AR 320x480
3.5"Diablo16HVGA Intelligent Touch Screen LCD Module and Adapter shield
-r 4.3"Diablo16 Intelligent LCD Module and Adapter shield

Scroll using mousewheel, or click and drag using left mousebutton

Workshop4 allows the users to write their Arduino code and customize their 4D graphics user interface at the same
time in a single integrated development environment.

Basic
Graphics { ‘ Graphics

The Arduino compatible Basic Graphics
environment enables the user to write Arduino
code directly to program this Arduino
compatible module. It requires no uSD card
and allows graphics primitives to be dragged
and dropped on the screen and placed in your
code. It utilises the Serial SPE library for the
processor used in the display, and therefore
embraces the full set of Serial SPE Commands
are available to the User, to produce the
Graphical User Interface required.

A visual programming experience, suitably
called Arduino compatible Extended Graphics,
enables drag-and-drop type placement of
‘Workshop4 objects to assist with Arduino code
generation and allows the user to visualise how
the display will look while being developed. A
uSD card will be required in order to hold the
graphics. It utilises the Serial SPE library for
the processor used in the display, and
therefore embraces the full set of Serial SPE
Commands are available to the User, to
produce the Graphical User Interface required.

In the meantime you can continue developing
Genie Arduino applications using the current
tools

& &

© 2017 4D Labs Semiconductors Page 17 of 49
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5.1. Basic Graphics

The Arduino compatible Basic Graphics environment enables the user to write Arduino code directly to program this
Arduino compatible module. It requires no uSD card and allows graphics primitives to be dragged and dropped on the
screen and placed in your code. It utilizes the Serial SPE library for the processor used in the display, and therefore
embraces the full set of Serial SPE Commands are available to the User, to produce the Graphical User Interface
required.

5.2. Extended Graphics

Avisual programming experience, suitably called Arduino compatible Extended Graphics, enables drag-and-drop type
placement of Workshop4 objects to assist with Arduino code generation and allows the user to visualize how the
display will look while being developed. A uSD card will be required in order to hold the graphics. It utilizes the Serial
SPE library for the processor used in the display, and therefore embraces the full set of Serial SPE Commands are
available to the User, to produce the Graphical User Interface required.

5.3. Genie Graphics

Genie
Graphics

An upcoming feature is an advanced environment called Arduino compatible Genie Graphics which utilizes the
popular ViSi-Genie technology that is available in most 4D Systems Intelligent Displays. It utilizes the genieArduino
library, and allows rapid development of GUI due to the powerful tools and widgets Workshop4 provides. Simply lay
the display out with the objects you want, set the events to drive them and then utilize the genie functions inside the
Arduino sketch to read or write information to those objects from the Atmel processor. This is a very clean and rapid
development environment.

In the meantime, you can continue developing Genie Arduino applications using the current tools.

© 2017 4D Labs Semiconductors Page 18 of 49
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6. Common File Menu

The File Menu is the first menu and common to all environments...

Recent (Click here to Clear)

W D R KS H U P P R o E’ Colorpicker-4DGenie

C:\Users\Public\Documents\4D Labs\Picaso ViSi Genie\ColorPiderADGenie

B30/3515 T30 AN Y

IDE Version 4.4.0.9 CLOCK.4DVisSi 11/1/2011 3:43 PM

C:\Users\Public\Documents\4D Labs\Picaso ViSI\CLOCKADVIS

SPIflashDemo.4dg 3/11/2014 7:59 AM

Create a new 4D Systems Project E CA\Users\Public|Documents\4D Labs\Diablo DesignerSashDemo.dg

Start building a new Visi, Genie, Designer or Serial program.

P.;‘ Print Setup P .
‘) Create a new 4D Labs Project
- = | Start building a new Visi, Genie, Designer or Serial program.
e
; Options

e < Create a new Project

'ﬁ"‘, '3 Start building a new program using the same settings as you

@ samples = last used (Arduino Extended Graphics 4Duino)
% it

4D SYSTEMS 4D LABS

TURNING TECHNOLOGY INTO ART SEMICONDUCTORS

Scroll using mousewhesl, or click and drag using left mousabutton

...with various buttons relating to the project that is open (or greyed out if no project is open):

. File-related buttons,
. Print-related buttons,
o And miscellaneous buttons, such as Help, Options and Samples.
© 2017 4D Labs Semiconductors Page 19 of 49
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6.1. File-Related Buttons

The buttons include all the actions related to projects: New, Open, Recent, Save, Save As, Zip Project and Close project.

The options include:

Click New to create a new project. A dialogue window asks for the screen and the kind of project.

e saness vz eusler]

B |

Gen4-ulLCD-24D 240x320
2.4"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-ulLCD-24D-CLB 240x320
2.4"Gen4 Intelligent Display Module with embedded DIABLO16 processor w/ Cover Lens Bezel

Gen4-ulLCD-24DT 240x320

2.4"Gen4 Intelli Display Module with embedded DIABLO 16 processor v/ Resistive Toudh
panel

Gen4-ulLCD-28D 240x320
2.8" Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-ulLCD-28D-CLB 240x320
2.8" Gen4 Intelligent Display Module with embedded DIABLO16 processor vif Cover Lens Bezel

Gen4-ulLCD-28DT 240x320

2.8" Gen4Intelligent Display Module with embedded DIABLO16 processor wj Resistive Touch
pan

Gen4-ulLCD-32D 240x320
3.2" Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-ulLCD-32D-CLB 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor w/ Cover Lens Bezel

Gen4-ulLCD-32DT 240x320
3.2"Gen4Intelligent Display Module with embedded DIABLO 16 processor v/ Resistive Toudh
1

Scroll using mousewheel, or click and drag using left mousebutton

Il EEE=E.

© 2017 4D Labs Semiconductors Page 20 of 49
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Click Open to browse and open an existing project. A standard Open window opens.

- w <« Users » Public » Public Documents » 4D Labs v O Search 4D Labs 2
Organise « MNew folder =~ 1 @
MNarne Date modified Type Size ~
3 Quick access
4Duino 4742016 9:20 AM File folder
5,..3 Dropbox (4D Team) 4DUpdates 472772017 217 PM File falder
& OneDrive Animated Buttons 47472016 9:20 AM File folder
Arduino 4742016 9:20 AM File folder
is iablo Designer 47272017 217 ile folder
= This PC Diablo Desig 472772017 2:17 PM File fold
& Network Diablo Serial 47472016 9:20 AM File folder
Goldelox Designer 4/4/2016 9:20 AM File folder
Goldelox Serial 47472016 9:20 AM File folder
Goldelox Vi5i 472772017 217 PM File folder
Images 472772017 217 PM File folder
Picaso Designer 4/4/2016 5:20 AM File folder
Picaso Serial 47472016 9:20 AM File folder
Picaszo Visi 472772017 217 PM File folder
Mimmrm WC Cmmim AFYTIINAT .17 NKA Cilm £ml e 7
£ >
File name: v| Alfites ) v

Select ViSi-Genie projects among the different kinds listed below to load a ViSi-Genie project:

All files (*.%) w

Designer projects (*.4dg)

Visi projects (*.4dVisi)

Visi Genie projects (*.40Genie)
4ADGL Misc files (*.ing* fng®.sys;™.lib *
4D Display Defintions (*.4DdisplayDef)
Basic Arduino projects (*.4dArdBasic)
usD Arduine projects (*4dArdUsd)
Genie Arduino projects (*.4dArdGenieg)
All files (*.%)
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Click Recent to list the recently accessed files, and click on the project to open it.

Options
&Y

Help

@O

Samples

9 o

(4 .

\ Create a new Project

aI 3 Start building a new program using the same settings as you
= last used (Arduino Extended Graphics 4Duina)

40 SYSTEMS

TURNING TECHNOLOGY INTO ART

Create d hew 4D Systems Pro_]ect E C:\Users\Public\Documents\4D Labs\Diablo DesignerSPHlashDemo.4dg

Start building a new Visi, Genie, Designer or Serial program.

Create a new 4D Labs Project

Start building a new Visi, Genie, Designer or Serial program.

Recent (Click here to Clear)

pRo ColorPicker.4DGenie 8/20/2013 10:30 AM

g
E“ C:\Users\Public\Documents\4D Labs\Picaso ViSi Genie\ColorFicker4DGenie

IDE Version 4.4.0.9 CLOCK.4DViSi 11/1/2011 3:43 PM
m C:\Users\Public\Documents\4D Labs\Picaso ViSi\CLOCKADVIS

SPIflashDemo.4dg 3/11/2014 7:53 AM

4D LABS

SEMICONDUCTORS Scroll using mousewhesl, or click and drag using left mousebutton

Click Save to save the modified projects.
Click Save As to create a copy of already saved project and give it a new name. A standard Save window opens and
asks for the location and the name:

“ = =~ I ¢« Users » Public » Public Documents » 4D Labs v | & Search 4D Labs pel
Organise v Mew folder == - o
MName Date modified Type Size ~
7 Quick access
4Duino 4/4/2016 5:20 AM File folder
£&# Dropbox (4D Team) 4DUpdates 4/27/2017 217PM  Filefolder
G OneDrive Animated Buttons 47472016 %:20 AM File folder
Arduino 4/4/2016 %:20 AM File folder
> EH This PC Diablo Designer 4/27/2017 217 PM File folder
= Network Diable Serial 47472016 20 AM File folder
N Goldelox Designer 4/4/2016 :20 AM File folder
Goldelox Serial 4/4/2016 %:20 AM File folder ¥
£ >
File name: | MNoMamel.4DGenie v|
Save as type: |\|"isi Genie projects (*.4DGenie) ~ |
~ Hide Folders Cancel

© 2017 4D Labs Semiconductors
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Click Zip Project to make a compressed file out of the project. This is especially useful when then project is large and
contains pictures and videos.

Click Close to close the current project. You will be prompted to save the changes to any modified project.

o Save Changes to MoMamel.4dg?

Yes Mo Cancel

6.2. Print-Related Buttons

The buttons include all the actions related to print:

|

w0 Print Setup

SF

—
e

Click Print Setup to setup the printer:

Printer
Mame: Microsoft ¥PS Documert Wiiter e Properties. ..
Status: Ready

Type: Microsoft XPS Document Writer w4
Where: PORTPROMPT:
Comment:

Paper Crientation
Size: Ad w (®) Portrait

Source: | Automatically select v () Landscape

Network... Cancel
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Click Print to print the project:

User Guide

Printer
Mame: Microsoft XP5 Document Writer W Properties...
Status: Ready
Type: Microsoft XPS Document Writer v4
Where: PORTPROMPT:
Comment:
Prirt range Copies
() Al Mumber of copies: 1 =
() Pages from:|1 | tu:|1 |
3 3 Collate

() Selection JQJ JQJ

Corce

© 2017 4D Labs Semiconductors
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Click Options to set the options for the current project:

Arduino  Compiler Designer Editor Environment Generated Files | Genie | License Serial Shortcuts  Updates  Visi  Warnings

Mote: 200,000 baud is a reliable baud rate match for 4D Systems displays to the Arduino. Due
to accumulated inherent baud rate error percentages in both systems, other rates above
56,000 are not reliable,

Default Baud Rate 200000

Default Sound Buffer | 1024 v

Comms Port Diablo com1 Fins
@ [i] RXPin |PAD ~

o1 T™XPin |PA1 w

Maximum String Length Each addition byte of string length uses 3 bytes of RAM.

This is for ‘mormal’ strings and should be doubled for Unicode strings. i.e.
If you use unicode strings set value to max unicode string length * 2

List objects by Alias name first.

Mounting... message |M0unting. .n | These strings can only contain ASCII
- characters. They can also indude the \n
Drive not mounted... message |DFNE not mounted... T | newline sequence.

X conce

Options include different panes. Select “Environment”.

Arduine  Compiler Designer Editor | Environment | Generated Files Genie License Serial Shortcuts Updates  Visi  Warnings

Reopen Files that were open when Waorkshop was dosed Image [ Video Resample Quality

v ) () Fastest
Show Hints O Scaled
W Save as Opens Both ) Box
Backup Files when saving () spline
Bili
Open files Collapsed O siinear
() Bicubic
Style: Dffice2010Blue v (® Lanczos
Tab Color |:|
X cance
Select the Style among different possibilities.
© 2017 4D Labs Semiconductors Page 25 of 49
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The Image / Video Resample Quality selection brings different options:

Fastest
Scaled
Box
Spline
Bilinear
Bicubic
Lanczos

Click Help to access help, with links to the 4D website:

To access the 4D systems home page

Workshop 4
Version: 4.4.0.9
Copyright: 2015 4D Systems

For Peer help and support

For manuals and other documentation visit the
downloads tab on the page for your product

To report documentation errors and other hardware or
software issues, raise a case from the contact page

L3

Also, see the Samples item for the location of various samples.

© 2017 4D Labs Semiconductors Page 26 of 49
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Click Samples to access examples from 4D, with pre-defined filters:

SAMPLES

samples were loaded onto your hard drive as part of the installation
process for Workshop

v 4D Labs - Click to browse all files
> 4Duino
» - Arduino
- Diablo Designer
- Diablo Serial - Click to browse
-- Goldelox Designer - Click for filtered browse
- Goldelox ViSi - Click for filtered browse
- Goldelox Serial - Click to browse
- Picaso Designer - Click for filtered browse
- Picaso ViSi - Click for filtered browse
- Picaso ViSi Genie - Click for filtered browse
- Picaso Serial - Click to browse
- ViSi Genie Magic (Picaso/Diablo) - Click to browse

4D has a codebase of useful code and snippets that may come in handy
Click here to wisit the Forum Codebase

The 4D website contains a host of application notes

Click here to visit the 40 App Notes

Also, see the Help item for the location of various help information.

L3

Click Exit to close Workshop4. You will be prompted to save the changes to any modified project.

o Save Changes to MoMamel.ddg?

No | [ Conce
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7. Designer Specific Menus

The Designer environment includes five menus:

7.1. Home Menu

The Home menu is the main menu.

EHR=E CEXOO 005 LO6 4 =

+
New Open Save SaveAs Print Cut Copy Paste Delete | Undo Redo | ClearAll Next Prev  Set Find Replace Goto Find Again  CollapseAll Expand All = Compile Comp'nload

[

% O

File Clipboard Undo/Redo Bookmarks Find Code Folding Compile

..with three groups of buttons:

. File-related commands,
. Build command,
o And the objects pane.

7.1.1. File-Related Buttons

The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and Print.

EBEE =

=
Mew  Open Sawe Save As  Print

File

7.1.2. Code-Related Buttons

The code related buttons include the standard Windows commands of Cut, Copy, Paste, Delete, Undo and Redo.

« S E X OB

Cut Copy  Paste Delete Undo Redo
Clipboard Undo/Redo
© 2017 4D Labs Semiconductors Page 28 of 49
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7.1.3. Bookmark Buttons

The bookmark buttons include Set a bookmark, go to Next or Previous bookmark and Clear All bookmarks.

% © O 5

Clear All Mext Prev Set

Bookmarks

Bookmarks are shown close to the line number:

Bookmarks are especially useful for large projects.

7.1.4. Find and Replace Buttons

The find and replace buttons provide the basic features for code.

Fird Feplace Goto  Find Again

Find

The Find button prompts for a string and highly it in the code:

4 b
mNoNamez‘ [x]

rm "Gend-ulCD-28DT"

#inherit "4DGL_16bitColours.fnc”

func main()

1

en T: e

16
& 4§ [Jwhole words []Case Sensitive @ This fle  (C)Filesin project () All open files 1match found

Use the up and down arrows to look for the previous and next occurrence. Check Whole Words and Case Sensitive.
Choose between This file and Files in progress and All Open Files.

® This fle () Files in project () All open files
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The Replace button searches for a string and exchanges it with another string:

4
[ NoName2= [x]

"Gend4-ulLCD-28DT" L

it "4DGL_16bitColours.fnc”

func main()

print("Hello World") ;

1
14 v
& 4£» ¢ [Owholewords []case Sensitive @rthisfle (O Filesinproject (O All open files

Same options as for Find apply.
The Goto button prompts for a line number:

Mew Line?

| |
Cancel

7.1.5. Code Folding Buttons

The code folding buttons allow to collapse or expand a function:

Collapse All  Expand All

Code Folding

This is especially useful for large projects.
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7.1.6. Compile Buttons

The Compile button launches the compilation of the project while the Comp’nLoad compiles and uploads the project

to the screen.

Compile Comp’nLoad

Compile
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7.2. Tools Menu

Tools
. & 4 21 [
Graphics usD PmimC RMPst Termlnal Termlnal Touch 4DGL
Composer Tester Loader 9600 115200  Calibration  uVGA Link

All the tools and utilities are grouped here:

e  Click PmmC Loader to start the PmmC Loader utility.

e  Click ‘“Terminal connect 9600’ to open the currently selected com port at 9600 baud in the Terminal program.

e Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the Terminal
program.

e Click Touch Calibration to calibrate the touch on the display. This tool is not available for all display modules.

e (Click 4ADGL uVGA Link to open a window which can interact with the uVGA, enabling a mouse and keyboard
to be used with the uVGA(GFX) module. Demo code is available from Workshop4.

e Click Graphics Composer to open the Graphics Composer tool. This tool is used for creating graphics for a
Designer project. If graphics is needed for a Designer project, it is recommended to use ViSi instead.

e  Clik uSD Tester to test the uSD card mounted on the display. Before clicking this button, make sure that the
uSD card is mounted on the display module.

e  Click RMPet to partition the uSD card. The uSD card must be mounted to the PC.

7.3. Comms Menu

This menu is in charge of the communication port:

Status at 9:29:59 AM
COM3
ULCD-430T-A [v2.0, 16/05/16]

. {uSD: 3.68 GB)

Comms

The use of this menu is described at the section Connect the Module.
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7.4. Project Menu

The Project menu includes different parameters and options...

m m Allow -ve Led and Custom - Gemnd-ulCD-230T -

Digits and leading blarks
RAM | Flash on Custom Digits

Destination Enhancements Display

...with three groups of buttons:

. Destination,
o Display selection.
o And Enhancements

7.4.1. Destination

The first group includes the options for the destination:

FAM Flash

Destination

Select the Destination among two possibilities:

e RAM means the display must be connected during build and that the program will be downloaded to the
display’s RAM memory once compiled. If RAM is chosen as the destination, the program is lost when the
display is turned off.

e  Flash means the display must be connected during build and that the program will be downloaded to the
display’s flash memory once compiled. If flash is chosen as the destination, the program is retained and will
be available after power cycling.

7.4.2. Enhancements

The second section contains a button for enabling the use of negative values for LED digits and custom digits objects
and for enabling the use of leading blanks on custom digit objects.

Allow -ve Led and Custom
Digits and leading blarnks
on Custom Digits

Enhancements
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7.4.3. Display Selection

The third section allows to select the screen. Clicking on the button...

- Gend-ulCD-280T -

Display

...opens a new window to select the screen:

Change Display X

= —

Gend-uLCD-280T -

Qrientation
(®) Portrait
() Landscape
(") Portrait Reversed
i) Landscape Reversed

Display and options shown for

X cos

Select the screen from the drop-down list:

Gend4-uLCD-280T b
Gen4-uLCD-230T ~
Gen4ulLCD-32D0

Gen4-uLCD-32D-CLE
Gen4-uLCD-32DT
Gen4-uLCD-32DCT-CLE [

Gen4-uLCD-330
Gen4-uLCD-35D-CLE
Gen4-uLCD-350T hd
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Define the orientation among the four options:

Orientation
(®) Portrait
() Landscape
(I Partrait Reversed
() Landscape Reversed

Confirm by clicking on or deny by clicking on x Cancel
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8. ViSi Specific Menus

The ViSi environment includes all the menus available with the Designer environment plus two additional menus:
View and Widgets.

Home

8.1. View Menu

The View menu includes one important tool for visualising the form:

& 00O ee

Object Reset Object
Fa 5 hot
Inspector m naps view  Locations

Possibly hidden Forms

Click on Snapshot to open a specific window of the form to enable a 1:1 screenshot of the display to me made.

42 Snapshot = O X

Zgqm
(&OZOSO‘%OSOG Refresh | Save  Save Screen

This window provides a zoom up to 4 times. The Save button allows to save the screen as an image.

Object Inspector, Form, and Reset View, all relate to the menus and tool bars used in Workshop4. These toolbars and
menus can be moved and detached from the side of Workshop4. Object Inspector and Form will bring to front the
relevant toolbar when clicked. If required, the toolbars can be reset back to their default location by clicking the Reset
View button.

Object Locations enables the user to copy the locations/coordinates of objects on the display, to the clipboard.
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8.2. Widgets Menu

The Widgets menu includes the objects pane with all the objects available to build the interface:

Widgets

[Hadcgﬂl.nds " Buttons  Digits  Gauges Inputs  Labels  Primitives | System/Media
= Pr gy =
e NE

The objects —also called widgets—are detailed in the ViSi User Guide.
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9. ViSi-Genie Specific Menus

ViSi-Genie includes five menus with specific ribbons and options.

Home

ViSi-Genie is codeless and thus completely different from the previous code-based environments, all the menus
relating to ViSi-Genie are detailed.

9.1. Home Menu

The Home menu is the main menu.

Build (Build)
Copy/load Copy/Load

File Euild

@1 AN 0o

IE ﬂ % s @ @ |Backgrounds  Buttons  Digts  Gauges 1f0 Inputs Labels Magic  primifves | SystemfMeda - [[3
p—y
Print

..with three groups of buttons:

e  File-related commands,
e  Build command,
e And the objects pane.
9.1.1. File-Related Buttons
The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and Print.

EFEOR=

1=
Mew Open Save SaveAs  Print

File

9.1.2. Build Button

The Build button launches the compilation and the upload of the project to the screen.

Build {Build)
Copy/load Copy/load

Build
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9.1.3. Objects Pane

The objects pane includes all the objects available to build the interface:

' Backgrounds  Buttons  Digits  Gauges )0  Inputs  Labels  Magic  primitves  SystemMedia |E|

@ A ‘_

e The objects are detailed on the ViSi-Genie User Guide.

9.2. View Menu

The View menu includes one important tool for visualising the form:

& 0O ee

Chject Form  Snapshot Reset Chject

Inspector view  Locations

Possibly hidden Forms

Click on Snapshot to open a specific window of the form.

42 Snapshot = O X

Zaqm
& 0203040506 Refresh Save = Save Screen

(

This window provides a zoom up to 6 times. The Save button allows to save the screen as an image.
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AR ®EBL SN H O E

Boot usD PmmC Terminal Terminal Touch ADGL
usD Renumber Tester Loader TS 3600 115200 Calibration WVGA Link

All the tools and utilities are grouped here:
o  Click Boot uSD to upload the boot-loader to the screen.

e  Click PmmC Loader to start the PmmC Loader utility.

e  Click ‘“Terminal connect 9600’ to open the currently selected com port at 9600 baud in the Terminal program.

e Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the Terminal
program.

e Click Touch Calibration to calibrate the touch on the screen. This tool is not available for all display modules.

e Click 4DGL uVGA Link to open an interactive window to use mouse/keyboard with the uVGA(GFX) module.

e Click GTX to launch the Genie Test Executor debugger.

For Diablo16 display modules, the Boot uSD icon is replaced with the Update Bank(s) and Run icon. For more
information on the Update Bank(s) and Run option, refer to section Genie Options.

@ L®en 6 O

|Update Bank(s} F b usD Pmim{C RIMPat Terminal Terminal Touch 401
and Run SOUMBET ecter  Loader 9600 115200 Calibration UVGA Link

Clicking the GTX button, a new screen will appear with the form and objects defined in the project:

E= Genie Test eXecutor

Port: COM 3 Dngsetmmen 7 3| Contrast 3600 baud

Active Form
Query
ColorPicker
Query

]

Set
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9.4. Comms Menu

This menu is in charge of the communication port:

Status at 9:29:59 AM
COM3
ULCD-430T-A [v2.0, 16/05/16]

{uSD: 3.68 GB)

Comms

The use of this menu is described in Connect the Module.

9.5. Project Menu

The Project menu includes different parameters and options...

Destination

Run

Initial Form

Run
o S " Y Form0

Genie

Comms Speed: 9600

Sound Buffer: 1024 -

Allow buttons
to be disabled

Allow -ve Led and Custom

Gemnd-ulCD-320T

Digits and leading blanks LANDSCAPE -
on Custom Digits
Enhancements Display

..with three groups of buttons:

e  Options for Genie,
e  Parameters and Enhancements

e And display selection.
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9.5.1. Genie Options

For Picaso display modules, the first group includes the options for Genie:

Destination Initial Farm
Run Bun
e TV FPE Musn Form0 B

Genie

e Select the Destination among three possibilities:

o Run RAM - The display must be connected during Build and the program will be downloaded to the
display’s flash memory once compiled. The user’s application will be stored in Flash, but will be run from
RAM.

o Run Flash - The display must be connected during Build and the program will be downloaded to the
display’s flash memory once compiled. The user’s application will be stored and run from flash, this uses
less memory on the display, but makes programs run slightly slower.

o uSD - The user’s application will be built and copied to the uSD card. From the uSD card the application
is loaded into RAM and run from there. This option requires the Boot uSD program to be uploaded to
the display’s flash, as seen in the menu Tools. This Boot uSD program loads the user’s application from
the uSD card at startup, and executes it.

P

Boot
ushD

e The initial form section allows the user to set which form will show upon boot up.

For Diablo16 display modules, the first group looks like as shown below.

Destination

Run Run
P LA PR Foch

A w0

Bank 0

Bank 1

) ) Bank 2
— Bank 3
Bank 4
Bank 5

Farm(

The additional drop-down menu allows the user to specify the target destination flash bank of the ViSi-Genie program.
The Diablo16 processor has six flash banks (Bank 0 to Bank 5), each of which has a capacity of 32 kB.

When Run Flash is selected, the destination of the ViSi-Genie program is the bank specified in the drop-down menu.
In this case, the display module needs to be connected to the PC during build time. The program will then be
downloaded to the selected bank and it will run from there. Take note however, that, after the display module is
power cycled, the program in Bank 0 always runs first.

On the other hand, when uSD is selected, the ViSi-Genie program will be copied to the uSD card. This option does not
require the display module to be connected to the PC during build time. However, this option requires the Update
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Bank(s) and Run program to be downloaded to Bank O of the display module’s flash memory. The Update Bank(s)
and Run program button is found under the Tools menu.

AXEEEN Y

|Update Bank(s} Renumber usD PrimiC Terminal Terminal Touch 4DGL
and Run Tester Loader 9600 115200  Calibration  UVGA Link

This Update Bank(s) and Run program checks the uSD card for ViSi-Genie program files and copies them to their
destination flash banks. After this check-and-copy process, the program in Bank 1 is executed by default. The Update
Bank(s) and Run program can be modified to run another bank besides Bank 1 if desired after the check-and-copy
process.

Note that Update Bank(s) and Run program stores the time and date information of ViSi-Genie program files (for all
banks) in Bank 0. Every time that the display module is power cycled, Update Bank(s) and Run in Bank 0 always runs
first and checks the time and date information of the ViSi-Genie program files present in the uSD card. By default, if
the time and date information of a ViSi-Genie program file in the uSD card is different from that of the last program
file uploaded to the specified bank, Update Bank(s) and Run automatically updates the bank.

It is also possible to modify the Update Bank(s) and Run program such that it updates the target banks only if the
corresponding ViSi-Genie program files in the uSD card have a newer time and date information.

For more information, refer to relevant application notes found on the application notes page.

9.5.2. Parameters

The second group includes advanced parameters:

Comms Speed: 9600 - Allow -ve Led and Custom
Allow buttons o .
t0 be disabied Digits and leading blarks
Sound Buffer: 1024 on Custom Digits
Enhancements

e Comms speed is the baud rate at which the serial command interface operates

e Define Sound buffer size for the amount of memory set aside for buffering wav (sound) files. For simple
sound files 1024 bytes should be enough. For complicate sound files to be played whilst video is displaying
may need as much as 4096 bytes.

e  Button objects have the ability to be shown and hidden accordingly by the host controller. To enable this,
click on the “Allow buttons to be disabled” button. Then use the GTX tool to see the appropriate commands
for enabling and disabling the buttons.

e The right-most button allows for enabling the use of negative values for LED digits and custom digits objects
and for enabling the use of leading blanks on custom digit objects.
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9.5.3. Display Selection

The last section allows selecting the screen, useful for converting a program from one display module to another.

Clicking on the button...

Display

- Gerd-ulCD-280T -

...opens a new window to select the screen:

Change Display *

PN o~

Gend-ulLCh-28DT ~

Orientation
(®) Portrait
(U Landscape
i) Portrait Reversed
() Landscape Reversed

Display and options shown for

Select the screen from the drop-down list:

Gen4-uLCD-230T

Gen4-uLCD-230T
Gend4uLCD-32D
Gen4uLCD-32D-CLE
Gend4-uLCD-320T

Gen4-ulLCD-35D
Gen4-uLCD-35D-CLB
Gen4-uLCD-350T

Gen4-uLCO-32DCT-CLE |,
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Define the orientation among the four options:

QOrientation
(@) Portrait
() Landscape
(I Partrait Reversed
() Landscape Reversed

Confirm by clicking on or deny by clicking on x Cancel

10. Basic and Extended Graphics Specific Menus

The Arduino compatible Basic and Extended Graphics environments include all the menus available with the ViSi
Environment with some additional options for Arduino Comms which can be found under Comms tab.

Status at 9:30:03 AM

COM 1
Device is not responding

. COM3 (4Duino) e

Comms Arduino Comms

The Arduino Comms refers to the COM port that the Arduino board is currently using.
The main difference between the Basic and Extended Arduino environments lies on the available widgets.
Since the Basic Environment is designed to allow users to create projects without the need for a uSD card, it only

allows the user to use primitive shapes and objects in the WYSIWYG window. The Extended Graphics on the other
hand gives additional support for 4D Graphics.
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11. Connect the Module

Connect the module to a USB port with the 4D Systems programming cable and select the Comms menu:

Above the Comms section, the violet light mentions no module is currently connected.

E Please select an

.. available port

Comms

Connect the 4D Systems programming cable/adaptor to the module and plug the cable into the USB port. Click on the
drop-down list and select the COM port relating to the 4D Programming cable/adaptor.

Please select an
-~ .
COMIE — available port
coM19 | _
coMzo |5 | Comms
com21 | |f
com22 )
COM23 L::hanglng onChanged [=]
CcoM29
L —

The light turns yellow while the connection is being established:

Status at 11:15:45 AM
Scanning Port

COoM 3

Finally, the light goes m when the connection is established.

Comms

Status at 11:15:45 AM

COoM 3
Gen4-ulLCD-32DCT-CLB-A [v2.0, 16/05/17]

Comms

The light turns @ when no module is attached to the selected port:

Status at 11:24:14 AM

COM 3 L :
Device is not responding

Comms
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12. Insert the Micro-SD Card

For Picaso, Picaso Lite, and Diablo16, the micro-SD card shall be FAT16-formatted. Partition can't exceed 4 GB. For
Goldelox, the micro-SD card shall not be formatted at all, it requires the SD card to be RAW.

To connect the micro-SD card, either:
[ ]

Insert the micro-SD card into the USB adaptor and plug the USB adaptor into an USB port of the PC.

Or

Insert the micro-SD card into a micro-SD to SD card converter and plug the SD card converter into the SD
card slot of the PC.

Check the micro-SD card is mounted, here as drive E:.

- mem e, e
@—C\)-\;E » Computer » ~ [ 3 | Search Computer )
Organize = AutoPlay Eject  Properties System properties Uninstall or change a program B~ 0 @
¢ Favorites 4 Hard Disk Drives (2)
| Local Disk (C:) Recovery (D:)
4 Libraries — p— —
591 GB free of 676 GB S 225 GB free of 21,4 GB
*& Homegroup 4 Devices with Removable Storage (2)
A Removable Disk (F:)
1 Computer ) DVD RW Drive (E:) =
&, Local Disk () <$ W 135 GB free of 186 GB
&, Local Disk (C:
a Recovery (D:)

e Removable Disk (F)

€ Network

Removable Disk (F) Space used: Total size: 1,86 GB
W7 Removable Disk

File syster: FAT

Space free: 1,85 GB

For Goldelox, if prompted to format the SD card, click no/cancel. Leave the card unformatted and Workshop4 will
handle the rest.
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13. Revision History
N

1.0 First Release Nov 19, 2012
1.1 Typos on Page 4 fixed Dec 17,2012
1.2 Added new content for Serial and fixed incorrect document references Feb 4, 2013
1.3 Amended details about Micro-SD card July 5, 2013
14 Amended details about Program Destination Mar 11, 2014
2.0 Updated formatting and contents May 1, 2017
2.1 Added information on target flash banks July 29, 2017
S2.1 Updated hyperlinks, 4D Systems July 29, 2017
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14. Legal Notice

Proprietary Information

The information contained in this document is the property of 4D Labs Semiconductors and may be the subject of
patents pending or granted, and must not be copied or disclosed without prior written permission.

4D Labs Semiconductors endeavours to ensure that the information in this document is correct and fairly stated but
does not accept liability for any error or omission. The development of 4D Labs Semiconductors products and services
is continuous and published information may not be up to date. It is important to check the current position with 4D
Labs Semiconductors. 4D Labs Semiconductors reserves the right to modify, update or makes changes to
Specifications or written material without prior notice at any time.

All trademarks belong to their respective owners and are recognised and acknowledged.
Disclaimer of Warranties & Limitation of Liability

4D Labs Semiconductors makes no warranty, either expressed or implied with respect to any product, and specifically
disclaims all other warranties, including, without limitation, warranties for merchantability, non-infringement and
fitness for any particular purpose.

Information contained in this publication regarding device applications and the like is provided only for your
convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with
your specifications.

Images and graphics used throughout this document are for illustrative purposes only. All images and graphics used
are possible to be displayed on the 4D Labs Semiconductors range of products, however the quality may vary.

In no event shall 4D Labs Semiconductors be liable to the buyer or to any third party for any indirect, incidental,
special, consequential, punitive or exemplary damages (including without limitation lost profits, lost savings, or loss
of business opportunity) arising out of or relating to any product or service provided or to be provided by 4D Labs
Semiconductors, or the use or inability to use the same, even if 4D Labs Semiconductors has been advised of the
possibility of such damages.

4D Labs Semiconductors products are not fault tolerant nor designed, manufactured or intended for use or resale as
on line control equipment in hazardous environments requiring fail — safe performance, such as in the operation of
nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines or
weapons systems in which the failure of the product could lead directly to death, personal injury or severe physical
or environmental damage (‘High Risk Activities’). 4D Labs Semiconductors and its suppliers specifically disclaim any
expressed or implied warranty of fitness for High Risk Activities.

Use of 4D Labs Semiconductors’ products and devices in 'High Risk Activities' and in any other application is entirely
at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless 4D Labs Semiconductors from any
and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any 4D Labs Semiconductors intellectual property rights.

15. Contact Information

For Technical Support: www.4dsystems.com.au/contact
For Sales Support: sales@4dsystems.com.au
Website: www.4dsystems.com.au

Copyright 4D Labs Semiconductors 2000-2017.
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